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Copyright Notices 
Presentation Control Panel is Copyright © 2010-2013 Christina Louise Warne for Soft-Answer 
 
Unauthorised reproduction or distribution of these programs, documents or any part thereof is 
unlawful and may result in civil or criminal penalties. 
 

Disclaimer 
I, Christina Louise Warne, make no representations or warranties with respect to my products, 
documentation or other supplied materials, disclaim any implied warranties of satisfactory quality or 
fitness for purpose.  I also reserve the right to revise the product and/or the associated 
documentation and other related materials at any time without obligation to notify any person of 
such changes or revisions. 
 

Trademark Disclaimer 
Product names, logos, brands, and other trademarks featured or referred to in this document and 
associated websites are the property of their respective trademark holders. 
These trademark holders are not affiliated with my products or websites, nor do they sponsor or 
endorse my products. 
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1 Introduction 
Presentation Control Panel is an add-in for Microsoft PowerPoint that is designed to make your life 
easier if you work with multi-target presentations.  What is a multi-target presentation? 
 
Simply put, it is one presentation that contains different sets of slides, possibly for slightly different 
audiences or different styles of presentation.  For example, you may have a generalised set of slides 
and the customer specific content that you wouldn't want any other customer to see.  Or you could 
have a short one day training course and a longer two day version that share a number of common 
elements. 
 
In both cases, you don't want to end up with lots of different presentations, each set up for a specific 
audience... maintaining them so the common elements stay in sync would quickly become a real 
problem. 
 
This is where Presentation Control Panel (or PCP for short) comes in. 
 
With its target and group tagging features it allows you to quickly set-up a presentation for a specific 
audience with just a few clicks of your mouse.  Never again will you have to go through your 
presentation manually hiding slides only to worry whether you've missed one. 
 
And PCP doesn't stop there.  With it's visibility controls, you can control the visibility of slides based 
on whether you are going to show the presentation, print it or export it (using PCP’s built in export 
function).  You can also have it remove the notes attached to the slides during the export to keep 
your presentation notes private. 
 
So without further ado, let's introduce Presentation Control Panel. 
 

2 Installation 
Presentation Control Panel is supplied as a ZIP file.  Simply unzip it to a temporary location and then 
run the included ‘Setup.EXE’.  During the set-up process, required Windows components such as the 
.Net Framework version 4 may be downloaded as required. 
 
Once installed, you can run PCP in trial mode (key features are disabled or limited).  If you have 
purchased a licence key, open PowerPoint and go to the ‘Presentation Control Panel’ tab. 
 
Click the ‘About’ button to display the About dialog.  This is used to manage your software licence.  
When the dialog is first displayed on a new installation, it will look like this:- 
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To activate your software, enter the registered user name in the ‘Username’ field and the licence key 
you wish to activate in the licence key field. 
 
Licence numbers look like this:- 
 

PCPXX-XXXXX-XXXXX-XXXXX-XXXXX-XXXXX-XXXXX 
 
Both items of data should be entered exactly.  If not, the activation will fail.  If the registration 
completes successful, the dialog will change to look like this:- 
 

 
 
You will I’m sure have noticed the other buttons available to you.  These are handy if you need to get 
in touch with support. 
 
If you want to move your licence, you can deactivate the installation by clicking the ‘Deactivate’ 
button.  Please be aware, there are deactivation restrictions place on the keys so do not expect to 
move your licence around too much as this is prevented by the licensing system. 
 
NOTE:- You should remove your software licence before you change your Microsoft Office 
installation or your PC. 
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The default location for installation is ‘C:\Program Files\Soft-Answer\Presentation Control Panel’.  
This directory will contain this user manual in PDF format, the add-in files themselves and a 
demonstration presentation. 
 
To un-install the add-in, use the ‘Add/Remove Programs’ features of the Control Panel. 
 
Your presentations will still contain the data used by PCP, so if you are evaluating the add-in and 
don’t plan on purchasing it, be sure to remove the target and group lists along with any other 
visibility flags etc. you’ve configured. 
 

3 The Presentation Control Panel Ribbon 
PCP uses the Microsoft Office Ribbon menu that became the standard Office menu with Office 2007. 
 

 
 

 
 
Above you can see the PCP ribbon in PowerPoint 2007 (top) and PowerPoint 2013 (bottom).  
PowerPoint 2010 is presented in a similar style to PowerPoint 2007.  Each section and the options it 
contains are detailed below. 
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3.1 Visibility 
The visibility controls are used to hide slides when the presentation 
is being prepared for showing or printing.  By default (providing 
they aren’t linked to particular targets or groups – more on that 
below), slides will be visible all the time. 
 
Hence the visibility controls allow you to select when you want to 
hide a particular slide. 
 

PowerPoint 
2007 and 2010 

 PowerPoint 
2013 

 

Hide On Print 
When a slide is tagged with this, it will be hidden when the 

presentation is prepared for printing.  If you prepare it for showing, 
the slide will be visible. 

  

 

Hide On Show 
As its name suggests, this is the opposite of ‘Hide On Print’.  Slides 
tagged with this are hidden when the presentation is prepared for 

showing. 
  

 

Hide From All 
Sometimes, you may want to hide a slide regardless of whether you 
are going to show or print the presentation.  This control allows you 
to do that.  You may be wondering when you may want to do this.  

Well, you may have a presentation that is used by a number of 
people and you may want to include instructions to other users.  

You can include the instructions as slides, tag them with this control 
and they will be hidden regardless of whether it is being prepared 

for showing or printing. 
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3.2 Export Visibility 
The export visibility controls are used to control the ‘visibility’ of 
slides during the presentation preparation and export processes.  
Unless otherwise specified, all slides will be included in the export 
and presentation preparation processes.  This may not always be 
appropriate so PCP provides these controls to control this visibility. 
 
 

PowerPoint 
2007 and 2010 

 PowerPoint 
2013 

 

Show In Export 
When a slide is tagged with this, it will only be visible when the 
presentation is exported.  When it is prepared for showing or 
printing, the slide will be hidden.  You should note that if you 
include a print handouts script in the presentation, the main 

visibility settings will be used. 
 

 

Hide In Export 
When a slide is tagged with this, it will be excluded form the 

exported presentation, but will be visible (depending on its main 
visibility settings) when the presentation is prepared for printing 

and showing.  

 

Remove Notes 
During the export process, various elements are removed from the 
presentation, for security.  The notes you attach to slides are not 

included in this stripping process as they can be used to convey the 
details of the slide.  But what if you don’t want your notes to be 

exported?  Tag the slides whose notes you don’t want to be 
included in the export with this state and they will be removed 

during the export process. 
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3.3 Target and Group 
The target and group controls are used to link slides to 
the selected target and group.  Slides can be linked to a 
number of different targets and groups.  Whilst each 
slide can be linked to a number of different targets and 
groups, you can only select a single target during 
presentation preparation or export, whilst you can select 
any number of different groups.  This allows you to 
prepare or export the presentation for a single target audience whilst being able to select a number 
of groups.  For example, you may have a generalised sales presentation with different groups for 
different products and a collection of pages tailored specifically for potential target customers. 
 

PowerPoint 
2007 and 2010 

 PowerPoint 
2013 

 

Target 
Using this drop down selector you can select which target the ‘Link 

To Target’ button is operating on. 

 

 

Group 
Using this drop down selector you can select which group the ‘Link 

To Group’ button is operating on. 

 

 

Link To Target 
Clicking this button will make or break the link between the current 

slide or slide range and the selected target. 

 

 

Link To Group 
Clicking this button will make or break the link between the current 

slide or slide range and the selected group. 

 
 

  



 

  11 

3.4 Clear 
Unlike the other options, the ‘Clear’ button pops up a menu with all the clear 
actions currently available.  The actions are outlined below.  You should exercise 
caution when using these commands as they are irreversible. 
 
 
 
 

PowerPoint 
2007 and 2010 

 PowerPoint 
2013 

 

Clear Slide Visibility Tags 
Selecting this option will clear all visibility tags on the currently 

selected slide or slide range. 

 

 

Clear Slide Target Links 
Selecting this option will clear all targeting links on the currently 

selected slide or slide range. 

 

 

Clear Slide Group Links 
Selecting this option will clear all the group links on the currently 

selected slide or slide range. 

 

 

Clear All Links To Target 
Selecting this option will remove all links to the currently selected 

target throughout the presentation. 

 

 

Clear All Links To Group 
Selecting this option will remove all links to the currently selected 

group throughout the presentation. 

 

 

Clear All Visibility Tags In Presentation 
Selecting this option will remove all visibility tags from all slides in 

the entire presentation. 

 

 

Clear All Target Links In Presentation 
Selecting this option will remove all target links from all slides in 

the entire presentation. 

 

 

Clear All Group Links In Presentation 
Selecting this option will remove all group links from all slides in 

the entire presentation. 

 
 

  



 

  12 

3.5 Tools 
This section of the ribbon provides access to the advanced tools built into 
PCP. 
 
 
 
 
 

PowerPoint 
2007 and 2010 

 PowerPoint 
2013 

 

Inspect Slides 
Selecting this option will open the slide inspector.  For more 

information please see Slide Inspector below. 

 

 

Export 
Selecting this option will open the export wizard.  For more 

information, please see Export Wizard below. 

 
 

3.6 Prepare 
This section of the ribbon provides access to the presentation preparation 
tools that you will use when getting your presentation ready to print or 
show.  For more information about the presentation preparation, please see 
Preparing Your Presentation below. 
 
 
 

PowerPoint 
2007 and 2010 

 PowerPoint 
2013 

 

For Print 
Selecting this option will prepare the presentation for printing. 

 

 

For Show 
Selecting this option will prepare the presentation for showing. 
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3.7 Settings 
There aren’t many settings within PCP, most of them relate to specific 
presentations and they are the target and group lists that are used to target 
slides during the preparation and export processes.  For more information 
about the target list editor please see Target and Group List Editor below. 
 
 
 

PowerPoint 
2007 and 2010 

 PowerPoint 
2013 

 

Target List 
Selecting this option will open the target list editor in ‘Target’ mode. 

 

 

Group List 
Selecting this option will open the target list editor in ‘Group’ mode. 

 
 

3.8 About 
No application or tool would be complete without an ‘About’ section.  PCP is 
no different, with the ‘About’ section providing access to the user manual PDF 
and the ‘About…’ box. 
 
 
 
 

PowerPoint 
2007 and 2010 

 PowerPoint 
2013 

 

Help 
Selecting this option will open the user manual PDF allowing you 

quick access to the installed help. 

 

 

About 
Selecting this option opens the ‘About…’ box which is used to 

provide you with version information and access to on-line support 
facilities.  It is also used to manage the software licensing used by 

PCP.  For more information about our software licensing, please see 
Software Licensing below. 
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3.9 Button Status 
There are three button states for most of the visibility and export control buttons.  They are Off, On 
and Mixed.  These states are explained below (Please note, these are indicative illustrations only.  
The exact look will vary depending on which version of Office you are using and which skin you have 
selected). 

3.9.1 Off 
The off state indicates the option is not enabled or in the case of 
group and target links that the page is not linked to the currently 
selected options.  This state can be displayed when either a single 
slide or a range of slides is selected.  In both cases, all selected 
slides do not have the option or link enabled. 

 
 

3.9.2 On 
The on state indicates the option is enabled or in the case of group 
and target links that the page is linked to the currently selected 
options.  This state can be displayed when either a single slide or a 
range of slides is selected.  In both cases, all selected slides have 
the option or link enabled. 

 
 

3.9.3 Mixed 
The mixed state can only be displayed when a range of slides is 
enabled.  It indicates that the slides in the range contain a mix of 
the on and off states.  When this state is enabled, clicking the 
relevant option will set all slides to the enabled state. 
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4 Preparing Your Presentation 
Now you’ve set up your presentations 
slide visibility and targeting links, it’s 
time to present.  So, if you’re going to 
print handouts, simply click ‘For Print’.  
Otherwise, click ‘For Show’.  PCP will 
then display the targeting dialog. 
 
Select the required target, the required 
groups and click ‘OK’.  The presentation 
will be prepared to your requirements 
with slide visibility being adjusted 
accordingly. 
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5 Slide Inspector 
 

 
 

Whilst it’s all very good being able to manipulate the visibility tags and target links on individual 
slides or a range of slides, it is easy to get a little lost in it all.  To try and make things a little easier, 
the slide inspector was created to show you the state of all the tags and links for all the slides, 
allowing you to cross check sections or slides to make sure everything is just so. 
 
What’s more, you don’t have to constantly change the selection in the target and group selectors to 
see what state the slides are in as both lists are presented as check box lists showing you the status 
of many items at once. 
 
When running in PowerPoint 2013, the icons used in the slide inspector look like this:- 
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The icons used on the inspector are the same as the buttons on the ribbon menu, so from left to 
right, the control columns are:- 
 

 Hide on print 

 Hide on show 

 Hide from all 

 Include in export 

 Exclude from export 

 Remote notes on export 

 Target list 

 Group list 
 
Unfortunately, PowerPoint, as mighty a beast as it is, does not provide a slide preview that we can 
use, so when the inspector opens, it has to systematically create all the previews.  For a large 
presentation, this can take a little while.  When this process is occurring, the form displays a progress 
bar to keep you informed of how it’s doing.  This can be seen in the screenshot below. 
 

 
 
Likewise, when you click ‘Save’, all the settings are written back to the presentation.  This too can 
take a while, so the progress bar will also be displayed then. 
 
IMPORTANT NOTE:- When running in demonstration mode, the slide inspector is still available, but 
the changes are not written back to the presentation.  It is made available in this way to allow you to 
more accurately assess the usefulness of the features provided by the full version. 
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6 Export Wizard 
As well as providing a quick and easy means of preparing a presentation for showing or printing, PCP 
also provides a means of exporting a presentation.  This allows you to leave a copy of the 
presentation you gave (during a training session for example) with your customers without leaving 
them with anything you may not want them to see. 
 
What might you not want them to see?  Slides that were not presented to them (e.g. slides destined 
for other targets that may contain sensitive information), your slide notes and of course the list of 
targets and groups.  Primary visibility information (whether to hide a slide for showing or printing is 
retained), as are print versions of the slides. 
 
When you select the export option from the PCP ribbon, you will be presented with the familiar 
targeting dialog.  Simply select the required targeting and click OK.  You will be presented with the 
following dialog. 
 

 
 
When you click yes, your presentation will be saved to ensure nothing is lost as substantial changes 
are made before the presentation is saved again, this time with ‘_exported’ tacked onto the 
filename.  The output file will be saved in the same directory as the original. 
 
IMPORTANT NOTE:- When running in demonstration mode, the export wizard is still available, but it 
will only include the first 16 slides in the export process.  If several of these slides are hidden during 
export or they are linked to targets or groups not included in the export, then the exported 
presentation will be considerably smaller than 16 slides.  It is made available in this way to allow you 
to more accurately assess the usefulness of the features provided by the full version. 
 

6.1 Printing Exported Presentations 
Exported presentations are prepared as though they are going to be shown, but you may wish to 
allow the user to print them.  To do this you will need to add some scripting to the presentation 
before it is exported.  You will also need to add a page that provides the user with instructions and a 
button that will do the printing.  The visibility for this page can be set so that it only appears in the 
exported presentation, typically you should set the ‘Hide on print’ and ‘Show in export’ visibility 
options. 
 
The script you should include in your presentation is shown in appendix A  and is included in the PCP 
install folder (Normally this is C:\Program Files\Soft-Answer\Presentation Control Panel)  as ‘PCP 
Print Handouts Script.TXT’.  You are free to use this script in presentations prepared with PCP only.  
It must not be used in any other presentations. 
 
The rest of this section will talk you through adding the script and setting up a page to perform the 
printing. 
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6.1.1 Step 1- Accessing the ‘Developer’ tab 
The first step in setting up the print wizard is to check whether you have access to the ‘Developer’ 
tab in the Office ribbon.  If you don’t see the ‘Developer’ tab, you can enable it using the steps 
below.  If you already have access to the ‘Developer’ tab proceed to 6.1.2 below. 
 

6.1.1.1 Office 2007 

First, select the ‘Office Button’ at the top left corner of the PowerPoint window.  A menu will drop 
down that should look something like this:- 
 

 
 
Select the ‘PowerPoint Options’ button at the bottom of the menu and the options dialog will be 
displayed as shown below. 
 

 
 
To enable the ‘Developer’ tab, simply check the box highlighted in the screenshot above and click 
‘OK’.  The ‘Developer’ tab should now be visible in the ribbon menu. 
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6.1.1.2 Office 2010 and Office 2013 

First select the ‘File’ menu at the top left corner of the PowerPoint window.  The window should 
now look something like this:- 
 

 
 
Select ‘Options’ from the menu on the left hand side.  The options dialog will be displayed.  Select 
the ‘Customize Ribbon’ option from the menu on the left hand side and the dialog should look like 
this:- 
 

 
 
To enable the ‘Developer’ tab, simply check the box highlighted in the screenshot above and click 
‘OK’.  The ‘Developer’ tab should now be visible in the ribbon menu. 
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6.1.2 Step 2 - Adding the script 
The next step is to add the print wizard script to the presentation.  To do this, select the ‘Developer’ 
tab.  You should not that there are minor differences between Office 2007 and Office 2010, but the 
options we will be using are the same in both. 
 
The ‘Developer’ tab for Office 2007 is shown below. 
 

 

 
Select the ‘Visual Basic’ option on the tab.  The Visual Basic editor will be displayed as shown below.  
Again, there are minor differences between Office 2007 and Office 2010 but, like the ribbon, the 
options we will be using are the same. 
 

 
 
To add the script to your presentation, right click the ‘VBAProject’ node in the tree on the left hand 
side of the editor.  A pop-up menu will be displayed, select ‘Insert’ followed by ‘Module’.  This menu 
is shown below. 
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When clicked, this will create a code container module in your presentation.  Simply copy and paste 
the contents of ‘PCP Print Handouts Wizard.TXT’ into this module.  If you wish to customise the 
printing options (by default, the wizard prints notes pages in full colour, without collation).  You may, 
proceed to step 3, if you’re happy with the defaults close the VBA project by selecting the ‘Close’ 
option from the ‘File’ menu.  If you are asked whether you want to save changes, click ‘Yes’. 
 

6.1.3 Step 3 – Setting print options 
If you are a long time user of PowerPoint, you will undoubtedly be familiar with it’s printing options.  
The print handouts script does not provide this dialog, so you should set up some basic options in 
the script itself.  By default, the wizard prints notes pages in full colour, without collation.  You may  
 
The three configuration options are defined below. 
 

6.1.3.1 Collation 

Collation controls the order in which pages are printed.  Lets say you have a presentation with 3 
slides and you want three copies. 
 
With collation enabled (msoTrue), the pages will be printed in this order:- 1,2,3 – 1,2,3 – 1,2,3.  With 
collation disabled (msoFalse), the pages will be printed in this order:- 1,1,1 – 2,2,2 – 3,3,3. 
 
Depending on quantities and the speed of your printer you may find it quicker to print with collation 
disabled. 
 

6.1.3.2 Print output type 

You will no doubt have noticed that PowerPoint provides a number of page layout options when 
printing.  Using the print wizard script you must select the one you deem most suitable within the 
script itself. 
 
The options available to you are shown below. 
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ppPrintOutputSlides 
This mode prints one slide per page with the slides 
occupying nearly a full page. 

 

 ppPrintOutputOneSlideHandouts 
This mode prints each slide on it’s own page with 

room for notes. 

 

 

ppPrintOutputTwoSlideHandouts 
This mode prints two slides per page with room for 
notes. 

 

 ppPrintOutputThreeSlideHandouts 
This mode prints three slides per page with a small 
dedicated area to the right of each slide for notes. 

 

 

ppPrintOutputFourSlideHandouts 
This mode prints four slides per page with some 
room for notes. 

 

 ppPrintOutputSixSlideHandouts 
This mode prints six slides per page with a minimal 

amount of room for notes. 
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ppPrintOutputNineSlideHandouts 
This mode prints nine slides per page.  There is 
more room for notes, but the slides are quite small. 

 

 ppPrintOutputNotesPages 
This mode allows you to include your slide notes 

(assuming you haven’t removed them all).  This can 
be handy for providing more detailed information 
to users of the presentation.  There is also ample 

room (unless your notes are quite long) for users to 
make handwritten notes. 

 
 

6.1.3.3 Print colour 

You can elect to print in plain black and white without grey scaling (ppPrintPureBlackAndWhite), 
black and white with grey scaling (ppPrintBlackAndWhite) or colour (ppPrintColour). 
 
When you have decided on your preferred options, you should modify the section of the script that 
controls these options.  This is clearly visible within the script but it shown below for easy reference. 
 

''------------------------------------------------------------------------ 
'' PrintHandouts configuration 
'' 
'' Collation - Possible options are:- 
''    msoTrue 
''    msoFalse 
.Collate = msoFalse 
'' Output type - Possible options are:- 
''    ppPrintOutputSlides 
''    ppPrintOutputNotesPages 
''    ppPrintOutputOneSlideHandouts 
''    ppPrintOutputTwoSlideHandouts 
''    ppPrintOutputThreeSlideHandouts 
''    ppPrintOutputFourSlideHandouts 
''    ppPrintOutputSixSlideHandouts 
''    ppPrintOutputNineSlideHandouts 
.OutputType = ppPrintOutputNotesPages 
'' Color Type - Possible options are:- 
''    ppPrintPureBlackAndWhite 
''    ppPrintBlackAndWhite 
''    ppPrintColor 
.PrintColorType = ppPrintColor 
'' 
'' You should not change anything else in this script as it could adversely 
'' affect the operation of the 'Print Handouts' functionality 
''------------------------------------------------------------------------ 

 
When you’ve finished modifying the printing options, close the VBA project by selecting the ‘Close’ 
option from the ‘File’ menu.  If you are asked whether you want to save changes, click ‘Yes’. 
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6.1.4 Step 4 - Adding the button 
This is the final step to providing a print handouts wizard in your presentation.  You should select (or 
create) a slide that will contain the ‘Print Handouts’ button.  The exact content of this slide will of 
course vary depending on what information you wish to provide to the user. 
 
The slide itself should be configured with the following visibility:- 
 

 
 
To add the button, you should select the ‘Developer’ tab and click the icon highlighted below:- 
 

 
 
Now, click and drag an outline in the slide.  You cannot do this over a text area.  When you have 
finished a button will be added to the slide as shown below:- 
 

 
 
If it isn’t already selected, click the button.  Within the ‘Developer’ tab, the ‘Properties’ option 
should be enabled as shown below.  
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Click it to open the property inspector. 
 

 
 
The text that is displayed within the button can be changed using the ‘Caption’ property.  Simply 
click in the cell you wish to change and modify it accordingly.  When you’re happy with the buttons 
appearance and the text it contains, double click it. 
 
  



 

  27 

The Visual Basic editor will be displayed with an empty routine as shown below. 
 

 
 
Add the command ‘printHandouts’. 
 

 
 
Close the visual basic editor and that completes the addition of the print handouts script to your 
presentation.  When the presentation is shown, the user should click the button in the presentation 
display area (it will not work if clicked in the presenter view).  When they do, the following dialog will 
be displayed to ask how many copies they would like to print. 
 

 
 
They simply enter how many copies they want and click ‘OK’.  Clicking ‘Cancel’ will cancel the print 
operation. 
 
NOTE:- You must tell the users of exported presentations that they may be asked if they want to 
enable macros when they view the presentation.  If they want to print from it, they must enable 
macros. 
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7 Target and Group List Editor 
Before you can use the advanced target and 
group linking features you must provide a list 
of valid targets and groups. 
 
When you select the ‘Target List’ or ‘Group 
List’ options from the settings section of the 
ribbon (For more information about the 
ribbon, see The Presentation Control Panel 
Ribbon above), the list editor is displayed as 
shown on the right. 
 
In this example, the list is operating in target 
list mode and contains two targets ‘ACME 
Widgets Incorporated’ and ‘Blogton 
Widgets’. 
 
This form is easy to use, simply enter the list 
of targets in the text area on the left.  Each 
target should be on it’s own line.  When you 
have finished editing your list, click ‘Save’ and the changes will be saved.  If you change your mind, 
clicking ‘Cancel’ will close the list editor without saving, just as clicking the ‘Close’ icon in the top 
right does. 
 
To clear the list and start over, click the ‘Clear’ button. 
 
NOTE:- If you remove an item from the list and save the changes, the system will automatically go 
through the slides and remove all references to the removed item. 
 
IMPORTANT NOTE:- When running in demonstration mode, the list is limited to 2 items. 
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8 PowerPoint Compatibility 
Presentation Control Panel is compatible with PowerPoint 2007, 2010 and 2013 and includes an 
Office 2013 compatible visual theme. 
 

9 Example Presentation 
PCP comes with a demonstration presentation that is pre-configured with a number of targets and 
groups to allow you to begin evaluating it immediately.  Since it is less than 16 slides long and only 
includes two targets and two groups, it can be fully processed by the demonstration version allowing 
you to use it for evaluation purposes. 
 

10 Demo Mode Limitations 
When operating in demonstration mode, PCP operates with the limitations outlined below. 
 

 The target list is limited to two items 

 The group list is limited to two items 

 The slide inspector will not save the changes made during its use 

 The presentation export will only process the first sixteen slides of the source presentation 

 The presentation processor (used to prepare the presentation for display or printing) will 
only process the first sixteen slides 

 

11 Software Licensing 
I operate a no nonsense licence policy.  Each licence key you purchase entitles a single user to use 
the product on up to two machines.  That’s it.  If three people use the same machine, then each of 
them must have a valid licence. 
 
To try and enforce some of these limitations, you must activate and deactivate your software with 
an active internet connection so PCP can communicate with my licensing service.  Once licensed, 
PCP will check on a random basis whether the licence details are still valid… if not, the licence on 
that machine will be deactivated. 
 
Once activated, you cannot deactivate a licence within a specified period of time, nor can you 
deactivate a licence more than 4 times in a 12 month period. 
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12 Support 
Support for Presentation Control Panel is provided via my support website at:- 
 
 http://support.soft-answer.co.uk 
 
Before raising a support request, please ensure you have fully read the user manual and the FAQs 
available on the support site relating to the product and the licensing service.  When posting a 
request for help, you should include your licence number and registered user name. 
 
You can also email support directly from Presentation Control Panel using the options on the ‘About’ 
dialog.  Please do not remove the licence information as this will be required before support is 
provided. 
 
If you are using the demonstration version and you have a question, please understand I have 
limited time (I have a day job) so it will be directed mainly to paying customers.  However, I 
appreciate people may have questions they would like answering before a purchase.  If you have 
such a question, please ensure it is clearly marked as such (please include ‘Pre-sales question’ in the 
subject line) so I can readily identify them and give them priority over non-customer support. 
 
This product came into being because I had a need that it fulfils very well, but it may be that it 
doesn’t quite meet your requirements exactly, so if you have feature suggestions please feel free to 
send them to me. 
 

13 About the Author 
I am a software industry veteran with (at the time of writing) nearly 20 years commercial experience.  
I write with what ever tool seems most appropriate (that includes C – normally for Microchip PIC 
devices, PHP, Pascal and C#) but my go to tool for general application development is Delphi and it’s 
particular flavour of Pascal. 
 
In my spare time I maintain a number of WordPress plugins, I try and write for (and provide website 
administration services to) the Pascal Game Development website.  I also maintain my own blog, my 
Soft-Answer brand and when I’m not doing any of those things, I might be writing, listening to or 
writing music, knitting or any one of a number of other pastimes (of which I have a lot). 
 
If you have a specific software  or PIC based project you think I may be able to help with, please get 
in touch to discuss it.  Please note though, I do have a full time job which I thoroughly enjoy (leading 
a small team of engineers producing software for the emergency services here in the UK) so I’m not 
looking for employment opportunities, just spare time projects. 
 

Thanks for reading, and hopefully, thanks for purchasing one of my products. 
Christina 

  

http://support.soft-answer.co.uk/
http://profiles.wordpress.org/athenaofdelphi
http://www.pascalgamedevelopment.com/
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14 Appendix A – Print Handouts Script 
 
''-------------------------------------------------------------------- 
'' 
'' Presentation Control Panel - Print Handouts Script 
'' 
'' Copyright (C) 2010-2013 Christina Louise Warne 
'' 
''-------------------------------------------------------------------- 
 
Option Explicit 
 
Private Const TAG_VIS = "PCP_VIS" '' Flag storage tag 
Private Const FLAG_HIDEONSHOW As String = "HS" 
Private Const FLAG_HIDEONPRINT As String = "HP" 
 
'' Wrapper around inStr to check for existence of 
'' a substring 
Function inString(aTagContent, aFlag) 
    inString = (InStr(1, aTagContent, aFlag, vbTextCompare) > 0) 
End Function 
 
'' Query the status of a flag in the control tag for 
'' the active slide 
Function isControlFlagSet(aSlide As Slide, aFlag) 
    Dim tagVal As String 
    If (aSlide.Tags.Count > 0) Then 
        tagVal = aSlide.Tags(TAG_VIS) 
        If (tagVal <> "") Then 
            isControlFlagSet = inString(tagVal, aFlag) 
        Else 
            isControlFlagSet = False 
        End If 
    Else 
        isControlFlagSet = False 
    End If 
End Function 
 
'' Hide slides which have the specified flag in their flag tag 
'' show all others 
Private Sub hideSlidesWithFlagSet(flag As String) 
    Dim S As Slide 
    For Each S In ActivePresentation.Slides 
        S.SlideShowTransition.Hidden = False 
        If (isControlFlagSet(S, flag)) Then 
            S.SlideShowTransition.Hidden = True 
        End If 
    Next 
End Sub 
 
'' Prepare the presentation for print 
'' (hide the slides we don't want printed) 
Private Sub prepareToPrint() 
    hideSlidesWithFlagSet FLAG_HIDEONPRINT 
End Sub 
 
'' Prepare the presentation for show 
'' (hide the slides we don't want shown) 
Private Sub prepareToShow() 
    hideSlidesWithFlagSet FLAG_HIDEONSHOW 
End Sub 
 
'' Configure the presentation and print 
Public Sub printHandouts() 
    Dim copiesStr As String 
    Dim copies As Integer 
    copies = 0 
    copiesStr = "1" 
    While (copiesStr <> "") And (copies <= 0) 
        copiesStr = InputBox("How many copies would you like?", "How many copies?", 1) 
        copies = Val(copiesStr) 
    Wend 
    If (copiesStr <> "") And (copies > 0) Then 
        prepareToPrint 
        With ActivePresentation.PrintOptions 
            ''------------------------------------------------------------------------ 
            '' PrintHandouts configuration 
            '' 
            '' Collation - Possible options are:- 
            ''    msoTrue 
            ''    msoFalse 
            .Collate = msoFalse 
            '' Output type - Possible options are:- 
            ''    ppPrintOutputSlides 
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            ''    ppPrintOutputNotesPages 
            ''    ppPrintOutputOneSlideHandouts 
            ''    ppPrintOutputFourSlideHandouts 
            ''    ppPrintOutputSixSlideHandouts 
            ''    ppPrintOutputNineSlideHandouts 
            .OutputType = ppPrintOutputNotesPages 
            '' Color Type - Possible options are:- 
            ''    ppPrintPureBlackAndWhite 
            ''    ppPrintBlackAndWhite 
            ''    ppPrintColor 
            .PrintColorType = ppPrintColor 
            '' 
            '' You should not change anything else in this script as it could adversely 
            '' affect the operation of the 'Print Handouts' functionality 
            ''------------------------------------------------------------------------ 
            .PrintHiddenSlides = msoFalse 
            .RangeType = ppPrintAll 
            .NumberOfCopies = copies 
            .PrintInBackground = msoFalse 
            .FitToPage = msoTrue 
            .FrameSlides = msoTrue 
        End With 
        ActivePresentation.PrintOut 
        prepareToShow 
        ActivePresentation.Saved = msoTrue 
    End If 
End Sub 

 

15 Appendix B – Software Revision History 
 

Date Version Changes 

25th September 2013 1.1.2 New - Added Office 2013 visual style 
New - Modified list editor – Icon now reflects current 
operation 
Change - Reduced licensing request timeout to 5 seconds to 
prevent unnecessarily long start-up time when not connected 
to the internet 

 1.1.1 Original release 

 

16 Appendix C – Document Revision History 
 

Date Version Changes 

25th September 2013 1.2 Updated to reflect support for PowerPoint 2013 

 1.1 Original release 
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